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Preface

This document is a formal contract deliverable with an approval code 1. It requires Government
review and approval prior to acceptance and use. This document is under ECS contractor
configuration control. Once this document is approved, Contractor approved changes are handled
in accordance with Class | and Class Il change control requirements described in the ECS Project
Configuration Management Plan, and changes to this document shall be made by document change
notice (DCN) or by complete revision.

This document is under the control of the EDF Configuration Control Board (CCB).
Any questions should be addressed to:

Data Management Office

The ECS Project Office

Raytheon Systems Company
1616 McCormick Dr.

Upper Marlboro, MD 20774-5301
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Abstract

This document describes the human-machine interface (HMI) characteristics of the tools (computer

software configuration items) used by the ECS operations staff and external users of ECS both
registered and non-registered.

Keywords: Computer Software Configuration Items (CSCIs), GUI, Interface, Operations,
Release 6A, Screens, Software, Tools
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1. Introduction

1.1 Identification

The Release 6A Operations Tools Manual, Contract Data Requirements List (CDRL) item 116,
whose requirements are specified in the revised Data Item Description (DID) 609/OP1, is a
required deliverable under contract NAS5-60000.

1.2 Purpose

This document describes the human-machine interface (HMI) characteristics of the tools
(configuration items) that will be used by the ECS operations staff when performing the following:

e computer systems administration

e system monitoring

= configuration management

e security and accountability

= science software integration and testing

e resource planning

= production planning and processing

= science data ingest, archive and distribution
e USer services

e common services

This document provides background information that is the basis for the Release 6A Operations
Procedures for the ECS Project (DID 611/0OP3). The 609 document is intended to (1) familiarize
the ECS operators with their tools, (2) be used as a reference for all ECS operational tasks, and (3)
be used as an aid during training of ECS operations staff.

1.3 Scope

This document applies to Release6A, and not to any subsequent releases of the ECS. This
document is limited to (1) a detailed description of customized operator tools, (2) a brief
description of Commercial Off-the-Shelf (COTS) software used by operations and references to the
applicable vendor manuals, and (3) a detailed description of customized COTS software. This
document will point to DID 611 for all operational procedures or to individual COTS manuals for
detailed COTS instructions. It is intended for use by operators, maintainers, and external users of
the ECS system during the period in which Release 6A is operational.
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1.4 Status and Schedule

This submittal of DID 609/0P1 meets the milestone specified in the Contract Data Requirements
List (CDRL) of NASA contract NAS5-60000.

This document reflects the February 14, 1996 Technical Baseline (210-TP-001-006) submitted via
contract correspondence No. ECS 194-00343.

1.5 Organization

This document is organized to describe the tools used by ECS operations staff and external users
during Release 6A.

Section 1.0 provides information regarding the identification, scope, purpose, status, and
organization of this document.

Section 2.0 provides a listing of related documents, which were used as source information for this
document. The section also identifies the documentation provided for each Release 6A software
component.

Section 3.0 provides a brief overview of the Release 6A ECS.

Section 4.0 provides a detailed description of Release 6A operations tools. It is organized by
operation function and provides the following types of information: tools overview, required
operating environment, CSCI function, operator commands, system messages, reports, and
outputs.

Appendix A provides a description of Release 6A system status and error messages, including
probable causes, impacts, and proposed actions.

The Abbreviations and Acronyms section contains an alphabetical list of the abbreviations and
acronyms used in Release6A.

The Glossary section contains terms used in this document.
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2. Related Documentation

2.1 Parent Documents

The parent document is the document from which the scope and content of this Release 6A
Operations Tools Manual has been derived.

423-41-02 Goddard Space Flight Center, Functional and Performance
Requirements Specification for the Earth Observing System Data and
Information System (EOSDIS) Core System (ECS)

423-41-03 EOSDIS Core System Contract Data Requirements Document

2.2 Applicable Documents

The following documents, referenced within this Release 6A Operations Tools Manual, are directly
applicable or contain policies or other directive matters that are binding upon the content of this
volume.

102-CD-002 Maintenance and Operations Configuration Management Plan for the
ECS Project
205-CD-002 Science User's Guide and Operations Procedure Handbook, Volume 4:

Software Developer's Guide to Preparation, Delivery, Integration and
Test with ECS

205-CD-004 Science User's Guide and Operations Procedures Handbook (Release
B.0) for the ECS Project

194-207-SE1 System Design Specification for the ECS Project

304-CD-003 Communications and System Management Segment (CSMS)
Requirements Specification for the ECS Project

305/DV2 Segment/Design Specification for the ECS Project

307-CD-002 Science Data Processing Segment Release and Development Plan for the
ECS Project

311-CD-600 Release 6A Data Management Database Design and Schema
Specifications for the ECS Project

311-CD-601 Release 6A INGEST Subsystem Database Design and Schema
Specifications for the ECS Project

311-CD-602 Release 6A Interoperability Subsystem (I0S) Database Design and

Schema Specifications for the ECS Project
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311-CD-603

311-CD-604

311-CD-605

311-CD-606

601-CD-001
604-CD-002
605-CD-002
609-CD-001

611-CD-004

613-CD-003
625-CD-601
625-CD-602

625-CD-603

625-CD-604

625-CD-605
625-CD-606

625-CD-607
625-CD-608
625-CD-009
625-CD-010

625-CD-011

Release 6A Planning and Data Processing Subsystem Database Design
and Database Schema Specifications for the ECS Project

Release 6A Science Data Server Database Design and Schema
Specifications for the ECS Project

Release 6A Storage Management Database Design and Schema
Specifications for the ECS Project

Release 6A Subscription Server Database Design and Schema
Specifications for the ECS Project

Maintenance and Operations Management Plan for the ECS Project
ECS Operations Concept for the ECS Project: Part 2B - ECS Release B
Release-B SDPS/CSMS Operations Scenarios for the ECS Project

Interim Release One (Irl) Maintenance and Operator's Procedures for
the ECS Project

Mission Operation Procedures - Ver. 2, Rel. 2.0, Drop 4.0 for the ECS
Project

Release B COTS Maintenance Plan for the ECS Project
Release 6A ECS Project Training Material Volume 1: Course Outline

Release 6A ECS Project Training Material VVolume 2: Introduction and
System Overview

Release 6A ECS Project Training Material Volume 3: Problem
Management

Release 6A ECS Project Training Material Volume 4: System
Administration

Release 6A ECS Training Material Volume 5: Network Administration

Release 6A ECS Project Training Material Volume 6: Production
Planning and Processing

Release 6A ECS Project Training Material VVolume 7: Resource Planning
Release 6A ECS Project Training Material VVolume 8: Ingest
Release 6A ECS Project Training Material VVolume 9: Data Distribution

Release 6A ECS Project Training Material Volume 10: Archive
Processing

Release 6A ECS Project Training Material Volume 11: Database
Administration
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625-CD-612 Release 6A ECS Project Training Material Volume 12: Configuration

Management
625-CD-613 Release 6A ECS Project Training Material Volume 13: User Services
625-CD-616 Release 6A ECS Project Training Material Volume 16: Science Software
Integration and Test
625-CD-617 Release 6A ECS Training Material Volume 17: System Troubleshooting
420-TP-007 Planning Workbench Detailed Design for the ECS Project
910-TDA-022 Custom Code Configuration Parameters-Rev01, November 2000

IMSV0-OP-GD-001 EOSDIS Information Management System, Users Manual for Release
6.0 of the VO IMS (April 1996), Hughes STX Corp., Upper Marlboro,
MD

IMSVO0-PD-SD-002 EOSDIS Information Management System, Messages and Development
Data Dictionary, VO and Release A Message Passing Protocol (1995),
Hughes STX Corp. Upper Marlboro, MD

2.3 Information Documents

The following documents are referenced herein, and amplify or clarify the information presented in
this document. These documents are not binding on the content of the Release 5B Operations Tools
Manual.

Action Request System 2.0, Troubleshooting and Error Messages Guide (1995), Remedy
Corporation, Mountain View, CA

Action Request System 2.0, User’s Guide for OSF/Motif (1995), Remedy Corporation, Mountain
View, CA

Accell Publication Package, Unify Corporation, Sacramento, CA
Accell Release Notes, Unify Corporation, Sacramento, CA

AlX Version 4.1 iFOR/LS System Management Guide First Edition (1994), Gradient Technology
Inc, 11400 Burnet Rd., Austin Tx 78758-3493

AIX Version 4.1 iFOR/LS Tips and Techniques First Edition (1994), Gradient Technology Inc,
11400 Burnet Rd., Austin Tx 78758-3493

AMASS Overview Version 4.9(1997), EMASS Inc, 10949 East Peakview Ave., Englewood, CO
80111

AutoSys User Manual, Version 3.2, August 1995, AutoSystems Development Lab, PLATINUM
Technology, Inc., Boulder, CO
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AutoXpert User Guide, Unix BETA Version 1.0, July 1995, AutoSystems Development Lab,
PLATINUM Technology, Inc., Boulder, CO

C Language Reference Manual (1995), Silicon Graphics, Inc., Mountain View, CA

ClearCase Administrator’s Manual, Unix Edition Release 2.0 and later (1995), 4000-013-B, Atria
Software Inc., Natick, MA

ClearCase Quick Reference Manual, Unix Edition Release 2.0 and later (1995), 4000-013-B, Atria
Software Inc., Natick, MA

ClearCase User’s Manual, Unix Edition Release 2.0.2 and later (1995), 4000-011-B, Atria
Software Inc., Natick, MA

Data Production Sofware and Science Computing Facility (SCF) Standards and Guidelines, Rev
A, October 1996, 423-16-01, GSFC, Greenbelt, MD.

DCE Cell Manager 1.6.2 Overview and User’s Guide (1997), Chisholm Technologies Inc, 6805
Capital of Texas Hwy, Austin Tx 78731

Displaying Information and Generating Reports (iFOR/LS) (1994), Gradient Technology Inc,
11400 Burnet Rd., Austin Tx 78758-3493

Errors and Corrective Action (AMASS) Version 4.9 (1997), EMASS Inc, 10949 East Peakview
Ave., Englewood, CO 80111

Enterprise SQL Server Manager User’s Guide, Release 10.0.2 (1995), Sybase, Inc. Emeryville,
CA

Expert Analyzer Output File Format (1995), Network General Corporation, Menlo Park, CA

Expert Sniffer Network Analyzer Operations (1995), Network General Corporation, Menlo Park,
CA

FDDI Overview and Guide to Troubleshooting (1995), Network General Corporation, Menlo
Park, CA

Fortran 77, Language Reference Manual (1991), Silicon Graphics, Inc., Mountain View, CA

HP OpenView Using Network Node Manager, 1995, 3404 E. Harmony Rd., Ft. Collins CO
80525

HP OpenView, Network Node Manager Products, Installation Guide, 1995, 3404 E. Harmony
Rd., Ft. Collins CO 80525

IDL Reference Guide, Interactive Data Language (1991), Volumes 1 and 2, Version 4.0, Research
Systems, Inc., Boulder CO
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IDL User’s Guide, Interactive Data Language (1995), Version 4.0, Research Systems, Inc.,
Boulder CO

iIFOR/LS Administrator’s Guide (1994), Gradient Technology Inc, 11400 Burnet Rd., Austin Tx
78758-3493

IFOR/LS Installation Notes (1994), Gradient Technology Inc, 11400 Burnet Rd., Austin Tx
78758-3493

IFOR/LS Quick Start Guide (1994), Gradient Technology Inc, 11400 Burnet Rd., Austin Tx
78758-3493

iIFOR/LS Quick Start Guide, Hewlett-Packard Version (1994), Gradient Technology Inc, 11400
Burnet Rd., Austin Tx 78758-3493

llustra Installation and System Administration Guide (1995), Illustra Server Rel. 3.2, Illustra
Information Technologies, Inc., Oakland, CA

lllustra User’s Guide (1995), Illustra Server Rel. 3.2, lllustra Information Technologies, Inc.,
Oakland, CA

Intelligent Query and 1Q Access User’s Guide for Windows and Motif, Version 5 (1996), 1Q
Software Corporation, Norcross, Georgia

Introduction to SPARCworks, SunPro (1992), Sun Microsystems, Inc. Mountain View, CA

Installing and Configuring Amass Version 4.9 (1997), EMASS Inc, 10949 East Peakview Ave.,
Englewood, CO 80111

1Q Installation Guide for Unix Motif (1995), IQ Software Corporation, Norcross, Georgia

IQ System Manager’s Guide, Versions 3, 4, & 5 (1995), 1Q Software Corporation, Norcross,
Georgia

IRIX Networker Administrator’s Guide, Silicon Graphics Computer Systems (1995), 007-1458-
030, Mountain View, CA

IRIX Networker User’s Guide, Silicon Graphics Computer Systems (1995), 007-1458-030,
Mountain View, CA

Managing the AMASS File System Version 4.9 (1997), EMASS Inc, 10949 East Peakview Ave.,
Englewood, CO 80111

Microsoft Excel User’s Guide, Version 5 (1993-94), Microsoft Corporation

Microsoft PowerPoint User’s Guide, Version 4.0 (1994), Microsoft Corporation
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Microsoft Word, Version 6.0 (1993-94), Microsoft Corporation

MIPSpro Fortran 77 Language Reference Manual (1994), Silicon Graphics, Inc. Mountain View,
CA

Netscape Navigator Handbook (Version 3.0), S. Kronick, Netscape Communications
Corporation, Mountain View, CA

NetWorker Administrator’s Guide (1996), Legatto Systems, Inc., 3145 Porter Dr., Palo Alto CA
94304

NetWorker User’s Guide (1996), Legatto Systems, Inc., 3145 Porter Dr., Palo Alto CA 94304

Network/Communications Management, Volume 1, MT923 Physical Network Management
(1995), Accugraph Corporation, El Paso, TX

NASA/ESDIS Standards

Netscape Enterprise Server — Administrator’s Guide for UNIX, AOL/ Netscape, Mountain View,
CA

Netscape Enterprise Server — Programmer’s Guide for UNIX, AOL/ Netscape, Mountain View,
CA

Netscape Livewire — Developer’s Guide for UNIX, AOL/ Netscape, Mountain View, CA

Open Client DB-Library/C Reference Manual (1993) , Sybase Inc., 6475 Christie Avenue,
Emeryville, CA 94608

Open Client and Open Server Common Libraries Reference Manual (1993), Sybase Inc., 6475
Christie Avenue, Emeryville, CA 94608

ProDev Workshop Environment Guide (1994), Silicon Graphics, Inc., Mountain View, CA

ProDev Workshop User’s Guide Volume I: The Debugger, Build Manager, and Static Analyzer
(1994), Silicon Graphics, Inc., Mountain View, CA

ProDev Workshop WorkShop User’s Guide Volume II: The Performance Analyzer and Tester
(1994), Silicon Graphics, Inc., Mountain View, CA

PureDDTS Administrator's Manual, version 3.2, Pure Software Inc., Sunnyvale, CA
PureDDTS Manual Pages Reference Guide, version 3.2, Pure Software Inc., Sunnyvale, CA
PureDDTS User's Manual, version 3.2, Pure Software Inc., Sunnyvale, CA

Replication Server Administration Guide (1995), Sybase, Inc., Emeryville, CA
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Replication Server Commands Reference (1995), Sybase, Inc., Emeryville, CA
Replication Server Installation Guide (1995), Sybase, Inc., Emeryville, CA
Replication Server Troubleshooting Guide (1995), Sybase, Inc., Emeryville, CA

Sniffer Network Analyzer: Ethernet Monitor Operations (1995), Network General Corporation,
Menlo Park, CA

Sniffer Network Analyzer: FDDI Monitor Operations (1995), Network General Corporation,
Menlo Park, CA

SQL Server Error Message, (1995), Sybase, Inc., Emeryville, CA

SQL Server Troubleshooting Guide, (1994), Sybase, Inc., Emeryville, CA

SQL Server Utility Programs for UNIX, (1994), Sybase, Inc., Emeryville, CA
SQR3 Workbench, SQR User’s Guide (1995), version 3, MITI, Long Beach CA
The SQL Server Installation Guide, (1994), Sybase, Inc., Emeryville, CA

StdRef Chapter 12: Object Description Language (ODL) Specification and Usage,
http://pds.jpl.nasa.gov/stdref/chap12.htm

SYBASE SQL Server Error Messages, Releases 4.2-10.0.2, (1995), Sybase, Inc., Emeryville,
CA

SYBASE SQL Server System Administration Guide (1994), Sybase, Inc, Emeryville, CA
SYBASE SQL Server Troubleshooting Guide (1994), Sybase, Inc, Emeryville, CA

Sybase SQL Server Reference Manual Vol. 1 and Vol. , (1994), Sybase, Inc., Emeryville, CA
System Administration Guide for SQL Server (1994), Sybase, Inc, Emeryville, CA

System Administration Guide Supplement (operating-system specific system administration tasks)
(1994), Sybase, Inc, Emeryville, CA

Tivoli Courier Users Manual, Tivoli Systems Inc., Austin, TX
Tivoli Enterprise Console Event Adapter Guide, (1995), Tivoli Systems Inc., Austin, TX
Tivoli Enterprise Console User’s Guide, (1995), Tivoli Systems Inc., Austin, TX

Tivoli Host Management Guide, (1995), Tivoli Systems Inc., Austin, TX
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Tivoli Management Platform User’s Guide (Release 2.5) , (1995), Tivoli Systems Inc., Austin,
TX

Tivoli/Sentry Monitoring Collection Reference Manuals, (1995), Tivoli Systems Inc., Austin, TX
Tivoli/Sentry User’s Guide, (1995), Tivoli Systems Inc., Austin, TX

Tivoli User and Group Management Guide, (1995), Tivoli Systems Inc., Austin, TX

UNIX Developer’s Tutorial, UNIFY Corporation, Sacramento, CA

UNIFY Developer's Reference (1989), UNIFY Corporation, Sacramento, CA

UNIFY Direct HLI Programmer's Manual (1989), UNIFY Corporation, Sacramento, CA

UNIX in a Nutshell, A Desktop Quick Reference, System V Edition (1994). Gilly, D. and staff of
O'Reilly & Associates, Inc., O'Reilly & Associates, Inc., Sebastopol, CA

Using the AMASS GUI Version 4.9 (1997), EMASS Inc, 10949 East Peakview Ave.,
Englewood, CO 80111

XRP-I1 Datalook/Datarite Reference Manual (1995), HTG, Ft. Worth TX

XRP-11 Product Information Manual (1995), HTG, Ft. Worth TX

XRP-11 System Reference Manual (1995), HTG, Ft. Worth TX

XRP-II Tools, Techniques, and Conventions Manual (1995), HTG, Ft. Worth TX

VolServ Graphical User Interface Guide (1995), VolServ, version 2.3, EMASS, Englewood, CO
Wabi User’s Guide (1993), Sun Microsystems, Inc., Mountain View, CA

Z-Mail for Motif Installation Guide, Version 3.2 (1994), Z-Code Software/NCD Software
Corporation, Novato, CA

Z-Mail for Motif Reference Manual, Version 3.2 (1994), Z-Code Software/NCD Software
Corporation, Novato, CA

Z-Mail for Motif User’s Guide, Version 3.2 (1994), Z-Code Software/NCD Software
Corporation, Novato, CA

Z-Mail Network License Server Installation and Maintenance Guide (1994), Version 1.8, Z-Code
Software/NCE Corporation, Novato, CA
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3. Release 6A Overview

3.1 Release 6A Objectives

3.1.1 Release 6A Capabilities

The Earth Observing System (EOS) Data and Information System (EOSDIS) Core System (ECS)
capabilities are developed in terms of formal releases. Release 6A, which is controlled by
Configuration Management, provides capabilities to support the ingest and archive of raw data
obtained from the EOS AM 1 mission spacecraft, morning equator crossing spacecraft series (Terra
(AM-1)), EOS PM 1 mission spacecraft, afternoon equator crossing spacecraft series (Aqua (PM-
1)) and the Land Remote-Sensing Satellite (Landsat 7). Other capabilities provided by Release 6A
include processing the data obtained, distributing raw or processed data as requested, quality
assurance of processed data, supporting communication networks, and systems monitoring via
interfaces with the ECS operations staff.

Release 6A unique capabilities include:

D3 Ingest — Provides the capability to ingest data from a D3 tape
Ingest ICESAT — Provides the ability to ingest ICESAT data via the INGEST SIPS interface

SBSRV FtpPull Acquires — Allows subscriptions to be submitted that specify an FTP Pull
Acquire as an action.

VOGW Access to Non-Science Collections — Enables searches to be conducted against non-
science collections and against granules without spatial and/or temporal metadata.

DDIST Data/Staging Logging — Provides Data Access and Staging Activity logs that record the
activities associated with archive processing.

Attached DPRs/JDT ODForms — Provides the capability to construct a standing Product
Processing Order associated with a Data Acquisition Request.

4000 DPR - Incorporates performance enhancement to facilitate the processing of 4000
DPRs/day.

Reprocessing — Capability incorporated to reprocess data products from any original or updated
single data input or combination of inputs.

Science Data Server Performance Improvements

e Batch Insert/Update — Optimizes SQL calls from the SDSRV to Sybase by grouping
multiple statements into a single batch and sending them to Sybase together.
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e Malloc Reduction — Reduces the number of malloc operations on search, insert validation,
and event notification to SBSRV

e Dirty Reads — Alolows dirty reads when receiving a large number of insert and search
requests at the same time

e Autoinspect — Stores meadata information in the SDSRV client so that some request from
the client to the SDSRV can be eliminated.

e Request Manager — Allos the STMGT client code to checkpoint requests directly to a database
and permits servers to handle requests within a fixed number of threads.

e V0 Gateway Enhancements — Ability to use EDG Client to perform searches on specified
attributes.

A more detailed overview of the Release 6A ECS may be found in the Release 6A Segment/Design
Specifications for the ECS Project, 305-CD-600-001.
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4. Description of the ECS Operational Tools

The human-machine interface (HMI) characteristics description of the software tools that the
ECS operator uses to perform routine ECS operations is listed by the following major functional

areas:

4.1
4.2
4.3
4.4
4.5
4.6
4.7
4.8
4.9

4.10
411
412

When using this document, the reader should note the following:

Computer Systems Administration
System Monitoring (Problem, Fault, and Performance Management)
Configuration Management

Security and Accountability

Science Software Integration and Test
ECS Data Ingest

Resource Planning

Production Planning

Production Processing

Science Data Archive and Distribution
User Services Tools

Common Services Tools

The screens/GUIs presented in this section are samples and often do not reflect the actual
window contents seen by the DAAC operator because they depend on hardware
configuration, actual server names, directories, etc.

Basic Unix, Network and application configuration and utilities are not explicitly
addressed in this document.

Launching tools from the command line is avoided as much as possible to give operations
management the ability to control (a) access to the Unix command line and shell; and (b)
reduce the use of the xterm except for programs other than Motif programs.

Release 6A directory structure is discussed in DID 612, which is the Programmer's
Manual for each of the Release 6A DAACSs and the SMC.

This document references the ECS Baseline Information System web page, URL
http://cmdm.east.hitc.com/, in several places for information on the Required Operating
Environment. This web page is currently being constructed for the desired information in
the ECS Baseline. Until it is put in place, the reader is referred to the DAAC library for
hard copies of the desired COTS documents.
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Note:

The sample GUI screen images provided in the tool description in this document
are best viewed on a computer terminal. The terminal provides the color and
resolution needed to convey the screen design and usage. A hard copy printout of
a screen image can lose all of its color and a great deal of its resolution in going
from a computer terminal to a printer to a xerox machine. The transition from
terminal to printer to xerox machine can cause the quality to degenerate to the
point the images are totally unreadable.
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4.1 Computer Systems Administration

This section describes the computer system administration tools used by DAAC operators:

Legatto’s Networker

DBVision

AMASS

ISQL

SQR Report Writer

Intelligent Query and 1Q Access
Sybase Replication Server
Global Change Master Directory (GCMD)
. ECS Assist

10. ECS Registry GUI

11. Whazzup GUI

CoNoRwWNE
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4.1.1 Legatto NetWorker

The Legatto Networker COTS Version 5.5 installed in ECS Release 5A has been verified to be
“Y2K” compliant.

Legatto’s NetWorker is a set of three components -Administration, Backup, and Recovery - used
by system administrators to back up the entire system, with the exception of DBMS files (see
Section 4.1.5, “ISQL”, for details on backup of DBMS files). The basic configuration is to have a
NetWorker Server with a backup device (i.e., Jukeboxes or 8mm tapes) networked to a number of
clients that represent the subsystem hosts.

Site-wide system backup is performed by NetWorker. It provides a suite of integrated tools for
backup and recovery, archive and retrieval, and hierarchical storage management. The product
supports multi-platform networks, contains a motif-based GUI with on-line help, and supports
concurrent device support for parallel backup and recovery using up to 16 storage devices. Both
scheduled and ad-hoc backups, recoveries and other data management services can be performed
by authorized users. NetWorker software consists of two components: a client portion, which runs
on the systems to be backed up, and a server portion, which is the system to which the backup
devices are connected. The client portion sends the data to be backed up to the server portion which
then writes the data out to disk.

NetWorker is used to perform the operator functions listed in Table 4.1.1-1.

Table 4.1.1-1. Common ECS Operator Functions Performed with

NetWorker
Operating GUI Description When and Why to Use
Function
Manage, configure, | = NetWorker Allows monitoring of server To start NetWorker (NW) tasks
and monitor Administrator | status, devices, sessions, and monitor server activity
NetWorker GuUI messages, and pending
displays
Monitor and e NW Backup e Group backup To back up client files
schedule backup GuUI » Scheduled backup
e Incremental backup
Recovering backed | « NW Recover | Retrieves files that have To recover backed up client
up files GuUI been backed up files

4.1.1.1 Quick Start Using NetWorker

This section presents an orientation of NetWorker. For more information, see the NetWorker
User’s Guide, and the NetWorker Administrator’s Guide, Using NetWorker Windows and
Menus.

The documentation used is for version 5.5 of NetWorker.

4.1.1-1 609-CD-600-001




4.1.1.1.1Invoking NetWorker From the Command Line Interface

The NetWorker Administrator tool is used to manage and configure the NetWorker environment.
To execute NetWorker Administrator from the command line prompt use:

nwadmin <-s server_name> &

The NetWorker Backup tool is used to backup files on client machines. To execute NetWorker
Backup from the command line prompt use:

nwbackup <-s server_name> &

The NetWorker Recover tool is used to recover files on client machines. To execute NetWorker
Recover from the command line prompt use:

nwrecover <-s server_name> &

Note: The optional <-s server_name> is used only in NetWorker environments that have multiple
NetWorker servers.

4.1.1.2 NetWorker Main Screen

Figure 4.1.1-1 shows the nwadmin screen. For more information on the NetWorker
Administrator, see the NetWorker Administrator’s Guide.
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File Clients Server Media Save Set Customize Options Help

| =l =l

Chonge
Server Mourt Urrnournt Indexes YWolumes
Server: sprisgiedc.cr.usgs.goy NetWeorker 4.1.1-12/08/95-15:21 Turbof10

Up since: Thu Jul 18 15:34:18 1996
Backups: 0 sessions
Recovers: 0 sessions

Devices:
sdev/rmttps2dZznrnsvi]d &mm 5GE Cunmountad)
=
Sessions:
sprisgiedo.cr.usgs.govicralg] browsing
=
Messages:
Thu 15:35:15 index notice: nsrck is cross-chacking index for mo2sunedc =
Thu 15:35:36 index notice: nsrck 15 cross—checking index for molsunedc |
Thu 15:36:00 Tndex notice: nsrck 15 cross-chacking index for mssisunedc =
Thu 15:36:20 index notica: nsrck 1s cross—chacking index for aitlsunadc =
Thu 15:36:46 index notica: nsrck 15 cross—chacking index for ait3sunedc El
=

Pending:

Figure 4.1.1-1. NetWorker Administrator’s Screen

Figure 4.1.1-2 shows the nwbackup screen. For more information on NetWorker Backup, see the
NetWorker User’s Guide.
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nwhackup

Figure 4.1.1-2. NetWorker Backup Screen

Figure 4.1.1-3 shows the nwrecover screen. For more information on NetWorker Recover, see the
NetWorker User’s Guide.
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nwrecover
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NetWorker Recover Window

Figure 4.1.1-3.

4.1.1.3 Required Operating Environment

For all COTS packages, appropriate information on operating environments, tunable parameters,
environment variables, and a list of vendor documentation can be found in a CM controlled
document for each product. To find the documentation for Legatto Networker, refer to the ECS
Baseline Information System web page, URL http://cmdm.east.hitc.com/.

4.1.1.4 Databases

The $Installed_dir/nsr/index directory maintains a database of files that have been backed up and
the availability of the backup such as tape number and whether it is online or on a volume of tapes
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that has been migrated. This information is in a proprietary format that can only be read using the
nwrecover tool.

4.1.1.5 Special Constraints
None.

4.1.1.6 Outputs

NetWorker provides the capability to print and save contents of a window as a way to maintain
records of NetWorker activities and configurations. For more information, see Chapter 3, Using
NetWorker Windows and Menus, NetWorker Administrator’s Guide.

4.1.1.7 Event and Error Messages

See Appendix A: Error Messages, NetWorker’s User’s Guide, and Appendix A: Troubleshooting,
NetWorker Administrator’s Guide.

4.1.1.8 Reports

None.
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4.1.2 DBVision (Future Release)
TBS

Note, this is a placeholder for the above tool that will be included in future releases. This tool will
also accommodate minor functions of SQL Monitor.
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4.1.3 AMASS

AMASS is a file storage management system (FSMS) for the UNIX operating system. The
purpose of AMASS in the EOSDIS Core System (ECS) is to provide an easy-to-use interface to
large media archives. Media is defined as tape and or optical drives. In terms of hardware, the
FSMS host in the ECS architecture is a Silicon Graphics Inc. (SGI) Challenge XL. There are two
main types of media libraries in ECS:

StorageTek (STK) Powderhorn using Redwood D3 50GB tapes
EMASS AML using IBM 3590 10GB tapes and/or HP 2600 2.6GB optical drives

STK Powderhorns are used at GSFC, LaRC, NSIDC and EDC. Powderhorns support only tape
media. Powderhorns consist of 6 major parts, the Automated Console System for Library Services
(ACSLS) which is a Sun Sparc 5 front end controller, the Automated Cartridge System (ACS),
Cartridge Access Port (CAP) where tape media are inserted and ejected, the Library Management
Unit (LMU) interface unit, Library Control Unit (LCU) to control the robot, Controller/Transport
Unit (CTU) racks which hold up to 4 D-3 tape drives and the Library Storage Module (LSM)
which includes the robot arms and the tape silo itself. The LSM includes a camera to display
operation to the operator and the tape drives. Note that ACSLS is connected to the network via
Ethernet.

EMASS Automated Media Libraries (AMLs) are used at the GSFC and EDC DAACs. AMLs
support tape and optical media simultaneously. The AML consists of four major parts, the
Automated Management Unit (AMU) which is an IBM OS/2 microcomputer controller for the
AML, the Entry Interface Facility (EIF) where media can be inserted or ejected from the AML, the
tower which is a multilevel turntable that stores the media, the tape and/or optical drives and the
robot(s) which take the media from the tower to a tape drive (which is called a mount) and from the
tape drive to the tower (which is called a keep). Note that the AMU is connected to the network via
FDDI.

Many ECS AMLs will be running two ‘logical’ jukeboxes because both tape and optical drives will
be included. This does not change the operation of the system but the operator must be aware to
use commands going to the correct jukebox. By convention, juke 1 has the tape drives and juke 2
has the optical drives.

The software components are more complicated. AMASS itself is the part that the user-of-the-
system actually uses. AMASS appears to the user as just another UNIX mount point and to and
from which one copies, moves or deletes files using standard POSIX dd, mv or rm commands. An
operator may view the contents of the archive, monitor the system, or setup new tapes for use
through standard commands found in the Managing the AMASS File System (Version 4.9). As of
AMASS Version 4.7.1 the volserv program has been replaced by a client/server system called
Distributed Archive Server (DAS) 1.3 on the AMLs and ACSLS on the STKs. DAS is the
‘glueware’ program that acts as a network transport for AMASS to communicate directly with the
AMU controller software and is loaded on the AMU. Once DAS has been configured correctly, it
should only need to be monitored unless there is a change to the hardware or for a software
upgrade. ACSLS combines the functionality of DAS and the AMU software in a single package.
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Once it has been configured correctly it should only need to be monitored unless there is a change
to the hardware or for a software upgrade. Telnet is configured on both AMUs and ACSLSs.
Lastly, there is a component that also runs on the SGI but it has no user configurable parts.

AMASS is installed on an SGI platform. Control information is communicated from the SGI to the
AMU using TCP/IP protocols via FDDI. Figure 4.1.3-1 shows the basic route that control
information takes in sending a file to AMASS to an AML or Powderhorn:

1. User/application initiates file transfer to AMASS

2. AMASS receives the file over the network via ftp, dd or cp or locally via dd or cp to amass
cache

3. AMASS sends information over the network to the AMU/ACSLS about what tape to load
and where to load it.

4. On an EMASS silo, the AMU rotates the tower to the correct position, sends the robot to
retrieve the tape, robot grips and retrieves the media and inserts it into the tape/optical drive to
complete the mount.

5. On an STK silo, ACSLS moves the arm to the media; the hand grips and retrieves the tape
and inserts it into the tape drive to complete the mount.

6. The data is finally written to tape.

@ SGI @
FDDI / I 7 .

LAN |
nfs/ftp / Y I
© ® mr—®
Ethernet
User Command on AMU/ Robotics
remote host ACSL AML/STK

Figure 4.1.3-1. Control Path

The data path is much simpler. A SCSI controller on the SGI is directly connected to the SCSI port
on the tape drive. Ideally, each drive gets its own controller. After the above process takes place,
AMASS writes the file to the tape in a very simple block by block method. Note that the format of
the tape is proprietary and NOT compatible with CPIO or TAR.
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AMASS uses both a command line and a GUI program called aawin to perform the system
administration/operator functions listed in Table 4.1.3-1.

Table 4.1.3-1. Common ECS Operator Functions Performed with AMASS
(1 of 3)
Operating Command or GUI Description When and Why to Use
Function
Boot AMASS | amass_boot Reboot AMASS Reboot AMASS
Start AMASS | amass_start Starts AMASS Initial startup.
Activate or amassstat Displays or toggles the Used to inactivate the file-
deactivate the | aawin GUI status of AMASS system for maintenance
AMASS file (ACTIVE/INACTIVE). and/or to reactivate it.
system
Add a volume | volnew Introduces a new volume to | To add storage space for
aawin GUI AMASS and assigns a data.
volume number.
Add space to | volnew Adds additional volumes to | When more space is required
a volume volgroup an existing volume group. in an existing volume group.
group aawin GUI
Create a volnew One or more volumes To allow AMASS to
space pool aawin GUI assigned to a special automatically add space
volume group of the Space | (volumes) to a volume group
Pool (SP). that has run out of space.
Create a volgroup Partitions the volumes in To assign volumes for
volume group | setvolgrp AMASS. specific purposes within
aawin GUI AMASS .
Delete a volstat Removes a volume and its To delete a volume and any
volume voldelete files from the archive. files it contains.
aawin GUI
Generate a amassreport Generates standard or user | To extract information about
report defined report and/or_raw files and directories from the
output. AMASS index.
Back up the amassbackup Performs full or partial back Any time that the system
AMASS index up of the AMASS index. needs to be backed up other
than what AMASSs
automatic backup provides.
Put a drive drivelist Displays the current status When an INACTIVE drive is
into service drivestat of the drives and to change | ready to return to service.
aawin GUI the status.
Recover dead | volspace Compresses a selected To recover dead space on
space volcomp volume. volumes.
volformat
aawin GUI
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Table 4.1.3-1.

Common ECS Operator Functions Performed with AMASS

(2 of 3)

Operating
Function

Command or GUI

Description

When and Why to Use

Reinitialize the

Refer to the vendor

Clears out the existing

Only when AMASS is not

AMASS index | documentation for index and reinitializes it to running.

the command and an empty index.

procedure
Reintroduce vollist Reintroduces an offline If data from an offline volume
an offline volslot volume to a jukebox. needs to be referenced for
volume bulkinlet read access.

volloc

Remove a vollist, voloutlet, Removes a volume or an To make room for new
volume or volloc entire volume group from volumes or because data not

volume group | aawin GUI the jukebox. being used needs to be
retained.

Remove vgroot #VG Removes space from one When space is needed in

space from a setvolgrp /path #VG volume group to add it to another volume group.

volume group volgroup another.

Replace a full | voloutlet 1, Initializes a new backup When the backup volume is

backup bulkinlet 0, volume and performs a full 95% full.

volume backup.

vollabel {to rename}
tapelength 1 2
volformat -b 256k 1
amassbackup -fv

Restore the amassrestore Restores the index either When the index is corrupt on
AMASS completely or to the point of | the magnetic disk
database the last full or partial backup. do not use the amassrestore
command when AMASS is
running.
Retrieve amassreport Displays the number of files | To get statistical information
system usage and directories owned by a | on the amount of space used
by user user and the amount of by an individual(s).
space they take up.
Retrieve adf Displays volume group, To get statistical information
system usage jukebox reference number, | about the usage of a
by volume position of volume, amount | particular volume.

of used space, number of
directories and files on
volume, amount of free and
dead space.
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Table 4.1.3-1. Common ECS Operator Functions Performed with AMASS

(3 of 3)

Operating Command or GUI Description When and Why to Use

Function
Reuse a (volcomp, volstat, Compresses and moves When a volume contains data
volume volclean, volformat existing data to another no longer needed or

aawin GUI volume, then reformats the | contains mostly dead space.
volume.
Take a drive drivelist, drivestat Displays and changes the When a drive has excessive
out of service | aawin GUI status of the drive. failures or for maintenance.
Kill AMASS killdaemons Kills AMASS execution. When system downtime
planned.

4.1.3.1 Quick Start Using AMASS

For more information about AMASS, refer to the Managing the AMASS File System and Using
The AMASS GUI guides.

The documentation of AMASS used as a basis and referenced in this section is for AMASS
49.1.1

4.1.3.1.1Invoking AMASS From the Command Line Interface

AMASS is normally started at boot and shutdown when the system is shutdown using scripts in
the /etc/rc2.d and /etc/rc0.d directories that are linked to the actual scripts in /etc/init.d. AMASS can
also be started and stopped from the command line.

To execute AMASS from the command line prompt use:
/usr/amass/tools/amass_start

To stop AMASS, type:
tldrg01 100> /usr/amass/tools/killdaemons

AMASS startup at boot can be enabled or disabled using the amass_atboot command. For more
information on accessing AMASS via the command line, refer to Chapter 3, Command Reference,
Managing the AMASS File System.

The AMASSADMIN GUI can be started from the command line by typing
/usr/amass/bin/aawin
For more information on running the AMASS, refer to Using The AMASS GUI guide.

For a description of AMASS commands and the functions they perform, see Chapter 2,
Operational Tasks, and Chapter 3 , Commands of the Managing the AMASS File System.
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4.1.3.2 AMASS Main Screen

AMASS allows the operator to perform a subset of the command line functions, as well as query
online index and output results to a file for further processing. For more information on the
AMASS, refer to Using the AMASS GUI guide.

The window area of the AMASS Main Screen shown in Figure 4.1.3-2 is referred to as ‘The
Workroom’.

B N

=
-

[oFuming o Actve o RWEnabled W |

Figure 4.1.3-2. AMASS Main Screen (AAWIN)

AAWIN Pulldown Menu options:
File
Exit: Exits AMASS.
Clear Workroom: Clears the Workroom of all icons.
Tasks
Modify a Volume Group: Change configuration of Volume Group
Modify a Volume: Change parameters associated with a VVolume
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Admin
Scheduler: Opens the Scheduler Status window.
Sysperf: Opens the sysperf window displaying the status of the AMASS activity.
Preferences
Show/Hide Detail Windows: These windows give a brief description of the items the
mouse pointer is touching.
Help: Opens the Help Window.

AMASS Utility Bar options (the Utility Bar is a vertical toolbar on the right side of the Main
Screen)

Trash Can icon

Volume Group icon displays the volume group icons in the Workroom as shown in Figure
4.1.3-3.

Volume icon displays volume icons in the Workroom.
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File Tasks Admin Preferences

Backup Vol Vol 10 Vol 19 Vol 28 Vol 37

Vol 11 Vol 20 Vol 28 Vol 38

Vol 12 Vol 21 Vol 30 Vol 39

Vol 13

@ Running + Active 4 RW Enabled

Figure 4.1.3-3. AMASS Main Screen showing selected volumes
in the Workroom

4.1.3.3 Required Operating Environment
AMASS requires a UNIX environment. AAWIN requires an X-window server.

For all COTS packages, appropriate information on operating environments, tunable parameters,
environment variables, and a list of vendor documentation can be found in a CM controlled
document for each product. To find the installation and release notes for AMASS and ACLS, refer
to the ECS Baseline Information System web page, URL.

http://cmdm.east.hitc.com/.
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4.1.3.3.1Interfaces and Data Types

The commands and the AMASS GUI that operations staff use to interface with AMASS are
described in the Managing the AMASS File System and Using The AMASS GUI.

4.1.3.4 Databases

The File Storage Management System provided by EMASS Company includes the RAIMA
database product. AMASS utilization of the database is transparent to the operator.

4.1.3.5 Special Constraints
None.

4.1.3.6 Outputs

Output from the AMASS consists of the data displayed on the GUI described in Section 4.1.3.2,
database updates or additions to the database referenced in Section 4.1.3.4, error and event
messages described in Section 4.1.3.7, and reports described in Section 4.1.3.8 which may
produce file outputs in response to user actions or are printed.

4.1.3.7 Event and Error Messages
AMASS generates the following types of messages:

e Informational (AMASS_I): Informational messages inform you about a process or
situation. The status of AMASS is not changed when you receive an informational
message.

e Warning (AMASS_W): Warning messages inform you of situations that require
attention but do not inhibit the functioning of AMASS.

e Error (AMASS_E): Error messages require the immediate attention of the System
Administrator to insure the proper functioning of AMASS.

e System (AMASS_S): System messages indicate internal errors and should be reported
to the EMASS Technical Assistance Center (ETAC).
AMASS uses the standard syslogd function of the operating system for all of its warning, error
and system messages. This facility allows the system administrator to control the output
destination(s) of these messages.

With the /etc/syslog.conf file, the operator can control the destination of each of the message types.
The syslog.conf file is typically set up to log all levels of AMASS messages to var/adm/messages.
The console is typically set up to see all AMASS levels generated by the kernel facility and the
system and error level generated by the daemon facility.

For a description of AMASS event and error messages, refer to Errors and Corrective Action
(AMASS) manual.

4.1.3.8 Reports

AMASS reports provide information of the AMASS holdings using the amassreport report
generator. Specific reports may be tailored for specific information on the basis of selections by
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date, file, directory, errors, length, size, or IDs. All reports have the column

heading listed in

Table 4.1.3-2.
Table 4.1.3-2. Amassreport Column Headings
Heading Description
Name Name of file
Parent Record ID of Parent.
Last Accessed Last Accessed date on timestamp.
Mode Permission IDs.
Size File size in megabytes
File ID File Number.
uiD User ID
GID Group ID
Last Modified Date and time showing date the file was last modified.
Vol File is located on this volume number.

Table 4.1.3.-3 below lists two types of AMASS reports using the amassreport command.

Table 4.1.3-3. Amassreport Report Types

Output Description and Format
formatted report prints a column header at the top of each page
raw output prints data without a column header
can be used with other utilities to generate custom reports

The content of both types of tables is the same. The raw output type is meant to be used to provide
input for further processing to a more complete reporting system.

For information on using amassreport see Chapter 3, Command Reference, Managing the

AMASS File System.
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4.1.3.8.1

Sample Report

Figure 4.1.3-4 is an example of a formatted amassreport showing volume group 20.

NAME FILEID PARENT UID GID LAST MODIFIED LAST ACCESSED MODE
VOL SIZE

file_create 23 2 3137 20 Oct 21 10:06 Nov 06 18:17 drwxrwxr-x
tzeostfiles?l 171147 23 435 20 Oct 22 08:57 Nov 04 06:32 drwxr-xr-x
rza?ndomo_files 333451 23 435 20 Sep 1l 1996 Nov 04 08:04 drwxr-xr-x
sgrtiongd_random_files 1751199 23 3137 20 Sep 25 1996 Nov 04 08:04 drwxr-xr-x
E)coz:)s_taz)e 2975809 2 435 20 Oct 22 1996 Nov 03 23:01 drwxrwxr-x

Figure 4.1.3-4. Amassreport example showing Volume Group 20
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4.1.4 ISQL

Interactive SQL (ISQL) is a stand-alone SQL command parser utility provided with the Sybase
SQL Server and is available on all platforms that Sybase is available. ISQL is executed directly
from the operating system level, and is used to interact with a SQL server and the databases on a
SQL server. It allows for the interactive issuance and execution of Sybase Transact-SQL
statements and sends the Transact-SQL commands to the SQL Server, formatting the results and
printing them on the standard output. ISQL is used to perform the operator functions listed in

Table 4.1.4-1.
Table 4.1.4-1. Common ECS Operator Functions Performed with ISQL
(1 of 3)
Operating Command/Script Description When and Why to
Function Use
Monitor See Chapter 1 - Overview | There are various Database and user activity
database and | of System Administration database management is monitored to manage
user activity in the System activities performed in and control various day
Administration Guide for Sybase SQL Server to to-day operations of the
SQL Server keep the databases DAAC and to prevent or
running for day-to-day resolve any unforeseen
operations problems
Provide and | * See Chapter 4- e Create user accounts, | eIt may be necessary to
control users' Managing SQL Server set account default provide access to
database Logins and Database databases and other individual users or
access Users in the System account configurable groups of users on a
Administration Guide for items temporary, permanent,
SQL Server « Grant proper or on-demand basis
e See Chapter 5 - permissions to user = Access to data at the
Managing User accounts DAAC should be
Permissions in the controlled so it is not
System Administration accidentally deleted,
Guide for SQL Server modified, or obtained
without permission
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Table 4.1.4-1. Common ECS Operator Functions Performed with ISQL
(2 of 3)
Operating Command/Script Description When and Why to
Function Use
Grant roles See Chapter 2 - Roles in Roles and user accounts | « Proper database

and assign SQL Server in the System | are necessary to provide management roles such
various Administration Guide for access and security to as SSO (System
privileges on | SQL Server databases under Security Officer), SA
database Chapter 5 - Managing User | Sybase SQL Server (System Administrator),
objects Permissions in the System OPER (Operator) are
Administration Guide for essential to the proper
SOL Server management of the
databases at DAACs
» Providing the proper
level of privileges to
each user of the
databases prevents any
accidental or
unforeseen mishaps
with the data (data
integrity is also
maintained)
Monitor, See Chapter 3 - Managing | < All databases running * Resources for storage
control, and Physical Resources in the under Sybase SQL and manipulation of
manage the System Administration Server are physically data are always at a
use of disk Guide for SQL Server stored on various premium
space, Chapter 6 - Checking devices and require « Proper management of
memory and | Database Consistency in various amounts of these resources is

connections

the System Administration
Guide for SQL Server

memory based on the
usage of data

e These resources have
to be properly
monitored

essential in reducing
errors, database
crashes and unwanted
downtime

Backup and
restore
databases

e See Chapter 7 -
Developing a Backup
and Recovery Plan in the
System Administration
Guide for SQL Server

= Chapter 8 - Backing up
and Restoring user
databases, in the System
Administration Guide for
SQL Server

« Chapter 9 - Backing up
and Restoring the
system databases in the
System Administration
Guide for SQL Server

Backup of databases
provides for quick
recovery and
maintenance of data
integrity

Most Database
Administrators perform
a daily backup of all their
databases and perform
recovery operations
when a database
crashes and is
unrecoverable by other
recovery methods

Proper backup and
recovery plans allow for
full, quick recovery and
zero loss of data
Regular backup of data,
is essential in reducing
downtime in case of a
database crash
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Table 4.1.4-1. Common ECS Operator Functions Performed with ISQL

(3 of 3)
Operating Command/Script Description When and Why to
Function Use
Diagnose e See Chapter 11 - » Diagnosing problems » Anytime the SQL server
system Diagnosing System with the operation of is not performing
problems Problems in the System SQL Server is a regular according to
Administration Guide for part of database expectation or any
SQL Server administration tasks database on SQL
« Also see the SYBASE +ISQL is used as a Server has crashed, the
SQL Server command line tool for problem(s) must be
Troubleshooting Guide interfacing with the diagnosed by checking
SQL Server current SQL Server
status information
« All problems must be
properly resolved for
successful operation of
SQL Server
Fine-tune See Chapter 12 - Fine A continuous operations | The SQL Server is fine
SQL server tuning Performance and and administration tuned whenever storage
performance | Operations in the System | activity that may involve or data requirements
Administration Guide for any of the above listed have changed, number of
SQL Server operating functions to users have changed, new
make sure SQL Server databases are added or
makes best use of its existing databases are
resources and to gain deleted, any SQL Server
maximum performance settings are modified, or
from SQL Server any external environment
changes have occurred
which may impact the
SQL Server

In addition, the DAAC user community may use 1SQL to:

e request data from various databases by issuing Transact-SQL statements
e insert, update, or delete data from various databases by issuing Transact-SQL statements
e change their passwords

4.1.4.1 Quick Start Using ISQL
This section presents an orientation of ISQL. For more information on ISQL, refer to the SQL
Server Utility Programs for UNIX.

Other manuals that the operator may find useful are:

e System Administration Guide for SQL Server (SQL Server administration issues)

» System Administration Guide Supplement (operating-system specific system administration
tasks)

e Open Client DB-Library/C Reference Manual (man pages and code samples for the SQL
Server interface library, Open Client DB-Library)
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e The SQL Server Installation Guide (installation procedures for SQL Server)
e SQL Server Reference Manual Vol. 1 and Vol. 2 ( commands and system procedures)

Further documentation support for Sybase’s ISQL can be found at the Sybase home page at:

http://www.sybase.com/

4.1.4.1.1 Invoking ISQL From the Command Line Interface
To execute ISQL from the command line prompt use:

isql
For detailed instructions on how to invoke ISQL see Chapter 3 - Using ISQL in the SQL Server
Utility Programs for UNIX guide.

4.1.4.2 ISQL Main Screen
There is no ISQL GUI. The ISQL uses a command line interface for operator communications.

4.1.4.3 Required Operating Environment
The utility program ISQL is invoked directly from the UNIX operating system via the command
line.

For all COTS packages, appropriate information on operating environments, tunable parameters,
environment variables, and a list of vendor documentation can be found in a CM controlled
document for each product. To find the documentation for ISQL, refer to the ECS Baseline
Information System web page, URL http://cmdm.east.hitc.com/.

4.1.4.3.1 Interfaces and Data Types

SQL Server requires an interfaces file to map logical server names to physical network information
about those servers. The interfaces file includes server name, network address, and the port
number on which the server listens on for queries. For detailed information on the interfaces files,
refer to the Open Client/Server Supplement for your operating system.

4.1.4.4 Databases

For more information on Sybase SQL Server databases, refer to the SYBASE SQL Server System
Administration Guide.

4.1.4.5 Special Constraints
None.

4.1.4.6 Outputs

Output from the ISQL consists of database updates or additions to the databases referenced in
Section 4.1.4.4, and error and event messages referenced in Section 4.1.4.7.
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ISQL does not provide formatting options for the output, but the -n option eliminates ISQL
prompts, while -e will include each command issued to ISQL in the output. Other tools can then be
used to reformat the output. For further information on formatting 1ISQL output, refer to the SQL
Server Utility Programs for UNIX manual.

4.1.4.7 Event and Error Messages

Sybase SQL Server issues both status and error messages from the SQL Server and ISQL formats
them to the designated output. For details on setting output options for ISQL the SQL Server
Utility Programs for UNIX manual.

For more information on error messages, their cause and corrective actions, refer to the SYBASE
SQL Server Error Messages manual.

4.1.4.8 Reports

None.
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4.1.5 SQR Report Writer (Future Release)
TBS

Note, this is a placeholder for the above tool that will be included in future releases.
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4.1.6 Intelligent Query and 1Q Access (IQ) (Future Release)
TBS

Note, this is a placeholder for the above tool that will be included in future releases.
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4.1.7 Sybase Replication Server (Future Release)
TBS

Note, this is a placeholder for the above tool that will be included in future releases.
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4.1.8 Global Change Master Directory (GCMD) (Future Release)
TBS

Note, this is a placeholder for the above tool that will be included in future releases.
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4.1.9 ECSAssist

The ECS Assistant (ECS Assist) is a custom program that simplifies the process of installation,
testing and management of ECS. This utility is basically an installation tool that has practical
application in the operations environment. The tool is for use in installing software and
maintaining the information related to that software. Only the Subsystem Manager function of
ECS Assist should be used in the ECS operational environment.

Table 4.1.9-1 summarizes the functions that ECSAssist provides.

Table 4.1.9-1. Common Tasks Performed with ECS Assist

Task

Description

When and Why to Use

Subsystem
Manager actions

Selections on the Subsystem
Manager’s screen, see section
4.19.2.1.

Installing software and performing
maintenance on software parameters.

Database Used to install, drop, patch, and When database updates or upgrades
update subsystem specific are implemented. See sections
databases. 4.1.9.21.1.

Install Used to install ECS custom software | As necessary to install software. See

into the selected mode.

section 4.1.9.2.1.2.

Shutdown Servers

Shutdown server(s) for a selected
component, application or
executable.

When restart of server is necessary or
server use has completed.

Configuration

Creates Configuration File (CFG),
Management Agent Configuration
File (ACFG) and Parameter
Configuration (PCFG) files for
selected components.

When installing or updating software
components. See section 4.1.9.2.1.4.

Registry Data

Used to update registry database

As desired for registry database

Patch updates. See section 4.1.9.2.1.6.
Stage Area Used to capture the location of the As desired to identify a staging area.
Installation delivered software staging area. See section 4.1.9.2.1.7.

Start Servers

Used to start servers within the
selected component, application or
executable.

Each DAAC has unique start scripts
that start one or all applicable servers.
This task is generally used during test
periods.

ESDT Manager

Supports configuring of ESDTs at the
DAAC.

As needed to configure new ESDTs at
DAAC.

View Task Output

Used to view task log files.

As desired to view log files. See section
4.1.9.2.1.8.

4.1.9.1 Quick Start Using ECSAssist
To execute ECSAssist from the command line prompt use the following procedure:

> /[EcCoAssist source_file location [ssh]
where source_file location can be:
/tools/common/ea — or —

lecs/formal/COMMON/scripts — or-
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any directory where Ecs Assist resides.
Type ssh, as an argument, if you want EASI to use Secure Shell to connect to hosts.
The default is to use Remote Shell.
>setenv DISPLAY <current_host>
>setenv ECS_HOME /usr/ecs
>setenv DEBUG 1 (Set only to capture any errors generated by Ecs Assist)
The /tools mount point must be mounted.
File /tools/common/ea must exist in the path. (This can be set in the .cshrc or .kshrc file)
>EA
...or, if this alias is not available, use the following:
> [tools/common/ea/EcCoAssist /tools/common/ea [ssh] &
A screen labeled "Thanks for choosing ECS Assistant” will appear for 5 seconds.
The following text will be displayed:
“debug is [ enabled | disabled ]” depending if DEBUG is set.

EASI will use [ Secure Shell | Remote Shell ] to connect to hosts...

4.1.9.2 ECSAssistant Main Screen

The ECS Assistant main screen shown in Figure 4.1.9-1 identifies the user, host machine, ECS
site and ClearCase view in effect. From the main screen, the user may invoke ECSASssist
functions as described in Table 4.1.9-2.

* ECS ASSISTANT [3.0]

Hie Help

subsystem Manager

ESDT Manager

EOSDIS

E.A 5. L

ISER: dclark
HOST: cherokee

Help SITE: EIF
MIEW: current_test

E it

Figure 4.1.9-1. ECS Assist Main Screen.
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Table 4.1.9-2 summarizes the information and capabilities presented on the ECS Assist Main

Screen.
Table 4.1.9-2. ECS Assist Options and Field Descriptions
Option/Field Action Description
User: Display only User’s logon ID.
Host: Display only Host on which executing.
Site: Display only ECS site ID.
View Display only Clearcase view in effect.

Toolbar menus

File

Click on File on the toolbar of the
ECS Assistant screen.

Pull down menu showing the following
options.

Clear Debug File

In the File menu, click Clear Debug
File.

Clear contents of debug log file.

Preferences

In the File menu, click Preferences.

Allows user to select preferences.

Exit

Click Exit

Terminates ECSAssist execution.

Help

Click on Help on the ECS Assistant
screen Toolbar.

Pulls down menu showing “Contents”,
“Read Me” and “About” selections.

Function buttons:

Subsystem
Manager

Perform software installation and
maintenance functions.

See Section 4.1.9.2.1.

ESDT Manager

Clicking this button invokes the
Earth Science Data Type (ESDT)
Manager

E.AS.L Clicking this button invokes the Allows one user to facilitate a complete
ECS Assist Simple Installation (FULL) or custom installation of ECS
(EASI) option. software.

Help Click on Help Brings up Help on use of ECSAssist.

Exit Click on Exit Terminates ECSAssist execution.

4.1.9.2.1 The ECSAssist Subsystem Manager

In the ECSASssist Main Screen, click on the Subsystem Manager button. Figure 4.1.9-2 below
presents the ECSAssist Subsystem Manager screen.
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= ECS ASSISTANT: Subsystem Manager User: delartk Host: blueridge Site: EDF

File Tools LHilities Help

Datahase | Install | Shutdown Servers | Configuration | Stage Area Installation | Start Servers | View Task Output

Frame 1—— Frame 2——
Mode: | hd —Settings
SUBSYSTEMS I ClearCase View: delark_RemoweCDS_EA
am cLs Selected Subsystem:
..... {7 css Selected Component:
----- i DM Selected Application:
----- {:' DP3
..... D DSS
----- {:' INGEST
----- ] 108 — Installation Statistics
----- {:' M33
..... D PLS
----- {:i TOOLKIT
..... E:l vocC
~ |«
— Legend
E}g Mot Installed
[ successfully Installed
D Installation Warnings
_f . Inztallation Errors

Figure 4.1.9-2. Subsystem Manager Screen
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The Subsystem Manager toolbar and Common Tasks options are described in Table 4.1.9-3.

Table 4.1.9-3. ECSAssist Subsystem Manager Toolbar (1 of 2)

Option/Field Action Description
Toolbar options:
File Click on File on the Subsystem | Pull down menu showing Save As and
Manager screen Toolbar. Close selections.
ESDT Manager | In the File menu, click ESDT Used to configure (copy) descriptor files
Manager. and associated shared objects to the
proper location.
Clear Debug File | In the File menu, clickClear Allows user to clear current contents
Debug File. from debug file
/[[HOME_DIR]/.EA_DebuglLog.
ClearTask Output File | In the File menu, click Clear Allows users to clear the file containing
Task output File. installation specific results.
Preferences | In the file menu, click Allows users to select preferences.
Preferences.
Exit | In the file menu, click Exit. Exits Subsystem Manager.
Tools
Clean Logs | In the Tools menu, click Clean | Allows users to remove outdated log files.

logs.

System Messages

In the Tools menu, click on
“System Messages”.

Displays system messages from
/var/adm.

Re-Read .sitemap file

In the Tools menu, click on
“Re-read .sitemap file”.

If there is a change to the .sitemap file,
this function re-reads to obtain the latest
information.

Override .sitemap file (EDF
Only)

In the Tools menu. click
“Override .sitemap file”.

Only available to EDF sites. Used for
custom sitemap files.

Registry Data Patch

In the Tools menu, click
“Registry Data Patch”..

Allows user to update registry database..

Utilities
DB Viewer | In the Utilities menu, click “DB Requires Database login to view inserted
Viewer”. granules.
Extensions | In the Utilities menu, click Pulls down menu showing a list of
“Extensions”. subsystem specific executables used for
supporting tasks.
Help Click on Help on the Displays latest information about Ecs

Subsystem Manager Screen
Toolbar.

Assist.
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Table 4.1.9-3. ECSAssist Subsystem Manager Toolbar (2 of 2)

Option/Field

Action

Description

Common Tasks

Area of the screen below toolbar containing the
following specialized task buttons.

database | Click on database button Used to install, drop, patch, and update
subsystem specific databases.
install | Click on install button Used to install ECS custom software into the

selected mode.

Shutdown Servers

Click on Shutdown
Servers button

When restart of server is necessary or server
use has completed.

Configuration

Click on Configuration
button

Creates CFG, ACFG and PCFG files for
selected components.

Stage Area Installation

Click on Stage Area
Installationbutton

Used to capture the location of the staging area.

start Servers

Click on Start Servers
button

Each DAAC has unique start scripts that start
one or all applicable servers. This task is
generally used during test periods.

View Task Output

Used to view task log
files.

As desired to view log files. See section
4.1.9.2.1.8.

Frame 1 Display Only

Mode Listbox Click Click to display a list of available modes.
Subsystems Double Click Double click to display associated components,
Hierarchical Listing applications and executables.

Frame 2 Display Only

Settings Display only Lists user’s current selections.

Installation Statistics Display only List installation specific statistics.

Legend Display Only When an install task has completed, a color of

Yellow, Red or Green highlights the selected
subsystem to denote the severity of the install
as follows:

Green - Perfect installation
Yellow - Install warnings
Red - Install errors

4.1.9.2.1.1 ECSAssist Subsystem Manager’s “database” Screen

The Database Configuration Screen is used to install, drop, patch, and update subsystem specific
databases. From the ECSAssist Subsystem Manager screen click the database button to initiate
the database process. If there is more than one database parameter file (.dbparms) detected when
the database button is pressed, ECSAssist will ask which one to use with the Select a File popup
window shown in Figure 4.1.9-3. The listbox in the lower half of this popup above the “Ok”
button contains the name of the database parameter files that were detected.
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= Select A file

You now have more than one
configuration parameters file.

File .dbparms contains ClearCase
defaults.

File .dbparm.” or .contain user specified
infonmation.

Flease select the appropriate file

.dbparms

.dbparms.1327
Ldbparms. 1393042615521
Jdhparms.daachame

Figure 4.1.9-3. File Selection Popup Window

Select one of the .dbparms files to use and then clicks on the Ok button. The fields for this
screen are described in Table 4.1.9-4.

Table 4.1.9-4. Database Parameter File Selection Field Descriptions

Option/Field Action Description
listbox Click on desired Contains list of .dbparms type files discovered.
parameter file Click on the one to use and then the Ok
button.
Ok Click this after selecting Launches database script screen associated
a .dbparms type file in with the selected parameter file in the listbox
the listbox.

On selection of a .dbparms file, ECSAssist brings up the Database Configuration Screen shown
in Figure 4.1.9-4.
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. Database Config Screen

EcDs SrDh Build

SQSSERVER [t1acq01_sgsz2z_srvr
GROUPNAME |DEVL
ENVIRONMENT |DAAC

oK

=

Cancel

Figure 4.1.9-4. Subsystem Manager “database” Screen

Table 4.1.9-5 describes the fields displayed on the "database" screen.

Table 4.1.9-5. ECS Assist Subsystem Manager’s “database” Field Descriptions

Option/Field Action Description
Database Config Screen Display only | Window title
EcDsSrDbBuild Display only | Component passed from the Subsystem Manager
screen
SQSSERVER Entry Configurable item for the displayed Component
GROUPNAME Entry Configurable item for the displayed Component
ENVIRONMENT Entry Configurable item for the displayed Component
OK Click Displays the database script screen
Cancel Click Aborts process

4.1.9.2.1.2 ECSAssist Subsystem Manager’s “database script parameters” Screen

This screen is triggered from the ECSAssist Subsystem Manager’s “database” screen, section
4.1.9.2.1.1 above. The screen is used to input the parameters to set up the database. In the
ECSAssist Subsystem Manager’s “database script parameters” screen, shown in Figure 4.1.9-5,
the user must enter all parameters to initiate the respective database script.
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* Database Script Parameters =] B3

Ec:DsSrDhBuild

Mode: DDCTEST
DBO 1D:

|

Passwond: |

S0L Server Hame: |
|

Database Name:

Ok Cancel

Figure 4.1.9-5. Subsystem Manager “database script parameters” Screen

Table 4.1.9-6 describes the control and information fields on the "database script parameters"
screen.

Table 4.1.9-6. ECS Assist Subsystem Manager’s “database script parameters”
Screen Field Descriptions

Option/Field Action Description
Database Script Parameters Display only | Window title
EcDsSrDbBuild Display only | Title
Mode Display only | Displays selected mode.
DBO ID Entry Enter dbo id
Password Entry Enter password
SQL Server Name Entry Enter sql server name
Database Name Entry Enter database name
OK Click Initiates process
Cancel Click Aborts process

4.1.9.2.1.3 ECSAssist Subsystem Manager’s Install Screen

This screen is used to install ECS custom software into the selected mode. From the ECSAssist
Subsystem Manager screen click the install button to initiate the installation process.

Figure 4.1.9-6 presents the Install screen.
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2. DDCTEST Mode Installation

Installation Type
~ Development

~ Hormal
o shLiEsne Ao

Source File Location

~s Stage
~+ Non Stage
| [[]] PACKAGES Size
r:..a .EcDsStarchive.pkg | 10650 kh
----- 1:] .EcDsStarchive Server.iu 2744 kb
..... {:I .EcDs3t3taging DiskServer.u 2635 kh
..... {:I .EcDs 5t Staging MonitorServer.iu 2535 kh
o E] .EcDsStRtpDisServer.u 2636 kh
----- i} -EcDsStD3pkyg unknown
----- E] .EcDs StDatabase.pky unknown
----- {1 -EcDs3tGUlpkg unknown
----- D .EcDsStingestFtp.pky unknowrn
----- {:! .EcDs StMediaDis.ply unknown
----- E] .EcDs StPullMonitor.pky unknown

----- {{] -EcDsS3tRequestManager.pkg ynknown

Use current site specific configuration values?
~r YBS
“ Mo

0k | Cancel |

Figure 4.1.9-6. Subsystem Manager Install Screen

Table 4.1.9-7 describes the control and information fields on the install screen.

4.1.9-10 609-CD-600-001



Table 4.1.9-7. ECS Assist Subsystem Manager Install

Field Descriptions

Option/Field Action Description

Installation Type Display only Heading.
Development | Click Creates symbolic links to ClearCase.
Normal | Click Copys binaries and libraries to selected mode.
Staging Area | Click Installs Mode from staging area.
Source File Location Display only Heading.
Stage Click To obtain files from the nightly build.
Non Stage Click Allows testing of changes before a merge to branch is
performed.
Standard Click Default setting. Used to list available packages.
Custom Click Not available in Release 4.
Packages Display only Heading.
Package Hierarchical | Click To select one or more packages
Listings
Double Click To display associated installable unit(IU) files

Installable unit list | Click To select on or more installable unit(1U) file(s)
Overwrite site specific | Display only Heading
configuration values
Yes Click Use site specific .cfgparms and .dbparms file.
No Click Do not use site specific .cfgparms and .dbparms file.

Allow user to make selection of choice.

Ok Click Executes installation process.
Cancel Click Aborts Installation process.

4.1.9.2.1.4 ECSAssist Subsystem Manager’s “Configuration File Selection”

Screen

The configuration file selection window shown in Figure 4.1.9-8 allows a user to select a
.cfgparms file with configuration values that were entered by the user or should be used when

starting servers.
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> Select A file

You now have more than one
configuration parameters file.

File .cfgpanms contains ClearCase
defaults.

File .cfgparms.” contain user specified
infonmation.

Hlease select the appropriate file

.cfgparms

.cfgparms.1527
.cfgparms.1327
.CTgpatms.19930426155215

Figure 4.1.9-8. Configuration File Selection Window

Table 4.1.9-8 describes the control and information fields on the configuration selection window.

Table 4.1.9-8. Configuration File Selection Window Field Description

Option/Field Action Description
listbox Click on entry in list Select file of choice; enables Ok button.
Ok Click Launches configurable parameters screen.

4.1.9.2.1.5 ECSAssist Subsystem Manager’s “Configuration” screen

Clicking the “Configuration” button on the ECSAssist Subsystem Manager screen brings up the

“mkcfg” window shown in Figure 4.1.9-9. Through this screen, ECSAssist creates CFG, ACFG
and PCFG files for selected components.
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*. Configurable Parameters

EcDsHdfEos Server EcDs ScienceDataServercClient EcDsScienceDataServer EcDs SdSrv Gui

EcDs SdSrv Guikkcfyg

0K Cancel Print

Figure 4.1.9-9. Subsystem Manager “Configuration” Screen

Table 4.1.9-9 describes the control and information fields on the "mkcfg" screen.

Table 4.1.9-9. ECS Assist Subsystem Manager “Configuration” Field Descriptions

Option/Field Action Description
EcDsHdfEosServer Click Allows user to configure EcDsHdfEosServer.
EcDsScienceDataServerClient | Click Allows user to configure

EcDsScienceDataServerClient.
EcDsScienceDataServer Click Allows user to configure EcDsScienceDataServer.
EcDsSdSrvGui Click Allows user to configure EcDsSdSrvGui.
EcDsSdSrvGuiMkcfg Display only
DSServerUR Enter User enters specific data to DSServerUR.
Ok Click Executes configuration process.
Cancel Click Aborts configuration process.
Print Click Prints configuration parameters.

4.1.9.2.1.6 ECSAssist Subsystem Manager’s “Registry Patch” Screen

Clicking “Apply Registry Data Patch Under the Tools menu option is the registry The registry
patch screen, shown in figure 4.1.9-10, allows users to apply updates to the registry database.
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= Apply Registiy Data Patch

Regiztry Databaze Server: I

Registry DBO Id: l

Registry Password: I

Regiztry IB Name: I

Tree to patch: I

Patch File: |

0k, |

Cancel

Select Patch File Help |

Figure 4.1.9-10. Subsystem Manager “Registry Patch” Screen

Table 4.1.9-10 describes the control and information fields on the "Registry Patch™ screen.

Table 4.1.9-10. ECS Assist Subsystem Manager’s monitor Field Descriptions

Option/Field Action Description

Apply Registry Data Patch Display Only | Window title

“Registry Data Server” Entry Database Server. e.g. tlicg01_srvr

“Registry DBO Id” Entry Database Owner ID. e.g. css_role

“Registry Password” Entry Database Password.

“Registry DB Name” Entry Database Name e.g. EcCsRegistry. After enter press
enter to fill available “Attribute Trees” into “Tree To
Patch” Combo box.

“Tree To Patch” Entry/Combo | Enter Attribute Tree name or click the arrow to select

box Attribute Tree of choice from list.

“Patch File” Entry Enter registry patch file which is to be used to apply
updates to registry database.

OK Button To apply updates.

Cancel Button Abort process.

“Select Patch File” Button Use to locate registry patch file.

Help Button Displays extra information related to application of

patch files.

4.1.9.2.1.7 ECSAssist Subsystem Manager’s “stage install” Screen

The stage install screen is used to input the staging location where the delivered software is
stored. From the ECSAssist Subsystem Manager screen click the stageinstall button to initiate

the viewlog process

Figure 4.1.9-11 below presents the stage install screen.
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< stage =] E3

Provide staging area source location

0k | Cancel |

Figure 4.1.9-11. Subsystem Manager “stageinstall” Screen

Table 4.1.9-11 describes the control and information fields on the stageinstall window.

Table 4.1.9-11. ECS Assist Subsystem Manager stageinstall Field Descriptions

Option/Field Action Description
Provide staging area source location | Display only Label for input field immediately below.
Input field Input Type in the staging area filename.
Ok Click Accepts the user’s entry.
Cancel Click Aborts the process.

4.1.9.2.1.8 ECSAssist Subsystem Manager’s “Task Output’ Screen

The task output screen allows users to view results as the specified task is executing. This
window is automatically displayed, if not currently displayed.

Figure 4.1.9-12 presents the “Task Output” screen.
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% Task Execution Feedback
Awaiting your command, your excellence,

01/14/01-17:13:45 CMD /fees/formal/COMMON/soripts/EcColnstall —custom EcDsSta fE
Installing package .EcDsStarchive.pkg in mode debtest on machine dss3.hite.co |
Btarted at Bun Jan 14 17:13:46 EST 2001

fecs/formal /COMMON/soripts/EcCoBcriptlib install -custom .EcDsStarchive.pkg d
Installing -custom .EcDs8tirchive.pkg debtest ZTAGE DEY DS EcDsSt

Copving /ecs/formal/COMMON/.installtypes to fusr/fecs/debtest/C
Copving fecs/formal/COMMON/.subsystems te Jusr/fecs/debtest/C
Copving fecs/formal/COMMON/ . hostmap to fusr/fecs/debtest/C
Copying fecs/formal/COMMON/ .sitehostmap to fusr/ecs/debtest/C
Copying fecs/formal/COMMON/.sitemap to fusr/ecs/debtest/C
Copying fecs/formal/COMMON/.applicaticons to fusr/fecs/debtest/C
Copving fecs/formal/COMMON/ .executables to fusr/ecs/debtest/C
Copying fecs/formal/COMMON/ . envvars to fusr/ecs/debtest/C
Expanding fecs/formal /COMMON/ . envvars to fusrfecs/debtest/C
Copying fecs/formal/D3S/ . components to fusr/ecs/debtest/C
Copying fecs/formal/DSS/stmgt/ . EcDsStarchive. pkg to fusr/fecs/debtest/C
Copving fecs/formal/D35/stmgt/.cfgpatch to fusr/ecs/debtest/C
Copying fecs/formal/DES/stmgt/.rgypatch to Jusrfecs/debtest/C
Generating Jusr/fecs/debtest/C
Copying fecs/formal/DES/stmgt/s.cfgparms to fusrfecs/debtest/C
Saving existing copy of /fusr/fecs/debLest/CUSTOMS.installed/DE5/stmgt/ . cfgparm
Copying fecs/formal/DEE/stmgt/.dbparms to fusr/ecs/debtest/C
faving existing copy of fusr/ecs/debtest/CUSTOMS. 1nsta11ed/DSS/stmgt/ dbparms
Hramrrimer fome fFmrma 1 M0 C S ok meart S marrrraae e o Fanemr L e FAAE ek A ?’
~d | -

ground color
Dizmizs |

Figure 4.1.9-12. Subsystem Manager “viewlog” Screen

Table 4.1.9-12 describes the control and information fields on the viewlog screen.
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Table 4.1.9-12. ECS Assist Subsystem Manager’s task output Field Descriptions

Option/Field Action Description
Task Execution Feedback Display only Window Title
“Awaiting your command, Display Label displaying command that is currently executing.
your excellence.” Variation When command has completed, the text “Awaiting
your command, your excellence” is displayed.
Text Box Display Displays output generated by executing command.
Press to search text Button Used to search contents within textbox.
Cancel Installation Button Used to search contents within text box
“Print” Click Used to print contents of text box.
“Foreground color” Click Used to change foreground color within textbox.
“Background color” Click Used to change background color within textbox.
Dismiss Click Closes Task output window

4.1.9.2.2 ECSAssist ESDT Manager
The ESDT Manager facilitates the configuration of ESDTSs into a mode.

Figure 4.1.9-20 shows the main window of the ESDT Manager.
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*. ECS5 ASSISTANT: ESDT Manager Uszer: dclark Host: dss3
# EDF -~ MIMI-DAAC. WATC and A1l DAACs Help

File Latest Info

Mode [DDCTEST s |

Staging Lucatiunl

DLL PathIKECSHFDPmaIKESDTKIibfsunE,E

GUT Information

Figure 4.1.9-20. ESDT Manager main window

Table 4.1.9-13 describes information and control fields on this window.
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Table 4.1.9-13. ESDT Manager Window Field Descriptions

Option/Field Action Description
File
Exit In the file menu, click Exit. Exits ESDT Manager.
Latest Info Click on Latest Info button Pulls down menu showing a list of subsystem specific

executables used for supporting tasks.

Radio Buttons

EDF Click radio button To set ESDT destination location for EDF sites.
MINI-DAAC, To set ESDTdestination location for NON-EDF sites.
VATC and all
DAACs
MODE list box Allows operator to designate which mode to configure
ESDT s.
DLL PATH entry Allows operators to designate the source location for
Dynamically Linked Libraries (DLL).
Staging entry Used to determine location of ESDTs and DLLs at
Location DAACS.
Configure button Initiates configuration of ESDTSs.
Verify button Verifys selected ESDT.

Instrument List

button(s) Aster(As),
Ceres(Ce), External
Ancillary(Ea), Edos(Ed),
Landsat(Ls), Miser(Mi),
Modis(Mo), Moppit(Mp), Sage
[lI(Sa) and System related
instruments(Sys)

Each button generates a list of instrument specific
ESDTs into “Descriptor Files” list box. Operator then
can select one or all into “Selected Files” list box.

Descriptor List Box (Gives number of Contains a list instrument specific ESDTs.
Files instruments in list.)
View File button Displays the contents of the selected ESDT.

Selected Files

List Box (Gives number of
instruments in list.)

Contains a list of selected instrument specific ESDTSs.

Remove button Remove selected ESDT from “Selected Files” list box.
Clear All button Removes all ESDTs from the “Selected Files” ;list box.
Results text box Displays results of the configuration process.
Current status bar Displays the directory of the currently selected
Directory instrument.
Directory status bar Displays directory statistics of the currently selected
Statistics instrument.

4.1.9.2.3 ECSAssist System Installer (E.A.S.I.)

E.A.S.I facilitates a complete or partial installation of ECS software, creation of configuration
and keytab files (CDS entries), and execution of database operations by a single user who is

familiar with the proper installation instructions.
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Figure 4.1.9-13 shows the E.A.S.I. Installation Source window which comes up as a result of
hitting the “E.A.S.1.” button on the ECSAssist main window.

~ E_A5.L Installation Source

Mode: [FRT |

Enter staging area zource location below

Type of Installation

o Fig
we Lusiom

Cancel Meuxt |

Figure 4.1.9-13. E.A.S.I. Installation Source Window

Table 4.1.9-14 describes information and control fields on this window.
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Table 4.1.9-14. ECS Assist E.A.S.I Installation Source Field Descriptions

Option/Field Action Description

Mode (combo box) Click To view a list of available modes. User can select one
mode.

Enter staging area source Display only Staging area source location field identifier.

location below

Staging area source location Enter if Staging area source location entry becomes available

entry available when a ClearCase view is not available. Enter the
staging area source location without the architecture
and with the word “TOOLKIT".

e.g. /net/tacoma/dist/DROP50

Type of installation Display only Identifies the installation options.

Full Click Facilitates a complete installation of ECS custom
software.

Custom Click Allows the user to facilitate a customized installation.
e.g. The user may only want to install on three hosts
or may only want to install Subsystem DSS on all
hosts.

Cancel Click Returns user to ECS Assist main menu.

Next Click When enabled, allows user to proceed to next
window.

Figure 4.1.9-14 is the E.A.S.I. Phase Selections window. The user can select any phase to
execute. Associated phase windows are displayed depending on what phases are selected .

~ E.A5.]l. Phaze Selection

I =] E3

_1 Install
_I Config

— Execution Phases

_| DBase(s)

Cancel

Back

Mext I

Figure 4.1.9-14. E.A.S.l. Phase Selection Window
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Table 4.1.9-15 describes the control and information fields on the E.A.S.I. Phase Selection
window.

Table 4.1.9-15. ECS Assist E.A.S.| Phase Selection Window Field Descriptions

Option/Field Action Description
Execution Phases Display Only | Identifies the option buttons for selecting phase of
installation.
Install Click on/off Selects installation of ECS custom software.
Config Click on/off Selects the creation CFG, ACFG and PCFG files.
Dbase(s) Click on/off Selects the execution of selected database operations.
Cancel Click Returns user to ECS Assist main menu.
Back Click Returns user to previously selected window.
Next Click Allows user to proceed to next window.

Figure 4.1.9-15 is the E.A.S.I. Installation Parameters window. It allows the user to select
Installation criteria. If a ClearCase task is not set or not available, the Installation Type will
default to Staging Area option .

0 ELALS L Installation Parameters !EE

Installation Type
~ Development

~ Mormal
we HEatfne Apon

Source File Location
~ o atage
+ Hon Stage

Cancel Back Mext |

Figure 4.1.9-15. E.A.S.I. Installation Parameters Window
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Table 4.1.9-16 describes the control and information fields in the E.A.S.I. Installation Parameters

window.

Table 4.1.9-16. ECS Assist E.A.S.I Installation Parameters Window Field

Descriptions
Option/Field Action Description
Installation Type Display Only | Identifies the three installation type options.

Development Click Creates symbolic links to ClearCase

Normal Click Copy binaries and libraries to selected mode.
Staging Area Click Installs mode from staging location.

Source File Location Display only Identifies the two options for selecting source file.
Stage Click To obtain files from the nightly build

Non Stage Click Allows testing of changes before merge to branch
Cancel Click Returns user to ECS Assist main menu.

Back Click Returns user to previously selected window.
Next Click Allows user to proceed to next window.

Figure 4.1.9-17 is the E.A.S.1.

require database operations.

Database Operations window. Select an operation other than
“Clear” and the subsystem specific script parameters will be displayed. Enter the correct
information for selected subsystem. You will notice that there is a tab for only subsystems that
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= E.A.5.1. Database Operations

Operations
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Cancel |
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Figure 4.1.9-17. E.A.S.l. Database Operations Window

Table 4.1.9-17 describes the E.A.S.l. Database Operations window control and information

fields.

Table 4.1.9-17. ECS Assist E.A.S.| Database Operations Window
Field Descriptions (1 of 2)

Option/Field Action Description
Operations Display Only | Identifies the button selectable Dbase options.
DbBuild Click Facilitates execution of database build operation.
DbDrop Click Facilitates execution of database drop operation
DbDump Click Facilitates execution of a database drop operation.
Dbpatch Click Facilitates execution of a database patch operation.
DbLoad Click Facilitates execution of a database load operation.
DbValids Click DSS Science Data Server only. Facilitates execution

of Valids script for use with ESDTSs.
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Table 4.1.9-17. ECS Assist E.A.S.| Database Operations Window
Field Descriptions (2 of 2)

Option/Field Action Description
Subsystems Display Only | Heading. By selecting a tab, the heading will change
specific script according to selection.
parameters
Mode Display only Displays selected mode.

Dbo Id Entry Enter Dbo Id.

Password Entry Enter password.

SQL Server Entry Enter SQL server name.

Name

Database Name | Entry Enter database name.

Cancel Click Returns user to ECS Assist main menu.
Back Click Returns user to previously selected window.
Next Click Allows user to proceed to next window.

Figure 4.1.9-18 is the E.A.S.I Installation Confirmation window. If there is an incorrectly
selected item, click the “Back” button until you have reached the window that requires the
change and make the change. When change is made click the “Next” button until you have
reached the “Installation Confirmation” window.

> E_A.5_l. Installation Confirmation

Pleaze review information below
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bajoran EcColnztall -custom EcClIMTFCSME.pkg FRT STAGE IEY CLS EcCl
bajaran EcCalhstall -custom ,EcClIMTFCSME_EDC.pko FRT STAGE DIEW CLS |
bajoran EcColhztall -custom EcClJdt,pka FET STAGE IEM CLS EcCl
bajoran EcColnztall -custom ,EcCl0dAsterOnlemand,pkg FRT STAGE DEM CI
bajoran EcColnstall -custom EcCsCommon,pkg FET STAGE DEY CSS EcCsId
bajoran EcColnstall -custom ,EcHsCommon,pkg FRET STAGE DEV MSS EcHafg
cheyenne EcColnztall -custom ,EcMsCommon,pkg FRT STAGE DEY HS!
cheyehne EcColnstall -custom EcInGUIOPSWS,pka FET STAGE TEY
cheyehne EcColnstall -custom EcCsCommon,pka FRET STAGE DEM CS
cheyenne EcColnztall -custom .EcDsStGUI,pkg FRT STAGE DEY DSS
dm=1 EcColnztall -custom EcCzCommon,pkg FET STAGE DEYM CSS EcC=Id
dm=1 EcColnztall -custom ,EclofdINTFCSWR,pkg FRET STAGE DEY I05S Ec
dm=1 EcCalnstall -custom EcMsCommon,pkg FET STAGE DEY MSS EckzAg
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Figure 4.1.9-18. E.A.S.I Installation Confirmation Window
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Table 4.1.9-18 describes the control and information fields in the E.A.S.l. Installation

Confirmation window.

Table 4.1.9-18. ECS Assist E.A.S.I Installation Confirmation Window Field

Descriptions
Option/Field Action Description
Please review information Display Only | Requests user to review the information immediately

below

below in a scrollable text box.

Information in Text Box Read only Contains log of installation.

Cancel Click Returns user to ECS Assist main menu.
Back Click Returns user to previously selected window.
Next Click Allows user to proceed to next window.

Figure 4.1.9-19 is the E.A.S.I STATUS window.

SEMSD STATUS
Utilities
£y EDF-OPS
#+{7] bajoran  (waiting)
_-!-_I-D cheyenne (waiting)
_-!-_I-D comanche (vaiting)
++-{] dss3 (waiting)
COH |
INSTALL
Cancel Back |

Figure 4.1.9-19. E.A.S.l. STATUS Window
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Table 4.1.9-19 describes the control and information fields in the E.A.S.l. STATUS window.

Table 4.1.9-19. ECS Assist E.A.S.I. STATUS Window
Field Descriptions

Option/Field Action Description

Utilities Menu

Close all open sockets Click Closes all opened connections. Waits for 4 minutes
and resets communication and selected phases to
“waiting”. This allows users to re-run selected
phases.

Max Requests Click Controls the number of server calls over the network.

COMM (Button) Click Initiates the communication phase. Starts servers on
selected hosts.

INSTALL (Button) Click Initiates installation of ECS custom software.

Click Initiates the creation of CFG, ACFG and PCFG files.

CONFIG (Button)

CDS (Button) Click Initiates creation of keytab files.

Status Bar (Status Indicator) Not available

Cancel Click Returns user to ECS Assist main menu. All
connections to the server are terminated.

Back Click Returns user to previously selected window.

Next Click To be used in later releases.

4.1.9.3 Required Operating Environment

For information on the operating environment, tunable parameters and environment variables of
ECSAssist refer to the 920-TDx-013 “Custom Code Configuration Parameters” documentation
series . The “x” refers to the installed location, e.g. 920-TDG-013 is for GSFC DAAC.

4.1.9.3.1 Interfaces and Data Types
None
4.1.9.4 Databases

No database is associated with or used by ECSAssist. ECSAssist may create entries in the CDS
catalog, create configuration files for software components, remove outdated log files, or update
other files related to the functions performed.

4.1.9.5 Special Constraints
None
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4.1.9.6 Outputs

Output from the ECSAssist tool consists of the data displayed on the GUIs described in
Section 4.1.9.2.1 and error and event messages described in Section 4.1.9.7

4.1.9.7 Event and Error Messages

Event and Error Messages for ECSAssist are listed in Appendix A in Section 2.7.5. All outputs
associated with ECS Assistant are captured in a file called “/tmp/<userid>.ecs_session.log”.

4.1.9.8 Reports
None
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